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Support Information
Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the 
products, services, and support that HP OpenView offers. 

HP OpenView online software support provides customer self-solve 
capabilities. It provides a fast and efficient way to access interactive 
technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest
• Submit enhancement requests online
• Download software patches
• Submit and track progress on support cases
• Manage a support contract
• Look up HP support contacts
• Review information about available services
• Enter discussions with other software customers 
• Research and register for software training

Most of the support areas require that you register as an HP Passport 
user and log in. Many also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html
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1 Introduction to this Manual

This guide explains the integration between Service Desk and OpenView 
Operations for Windows® and UNIX®. With the information in this 
guide you can install, configure and perform the various tasks available 
with this integration. 
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Introduction to this Manual
This guide is intended for IT administrators who will install and 
configure the integration, and for users who will perform the integration 
tasks. 

To install and configure the integration you must have knowledge of both 
the OpenView Operations application and Service Desk.

This guide is organized as follows:

• Chapter 2, “Integration Overview,” on page 13 describes the 
architecture of the OpenView Operations Integration and gives a 
brief explanation of the integration possibilities.

• Chapter 3, “OVO for Windows Integration Installation,” on page 21 
describes the installation steps that need to be performed on Service 
Desk and on your OVO for Windows server.

• Chapter 4, “OVO for Windows Integration Configuration,” on page 27 
explains how to configure the integration if you are using OVO for 
Windows.

•  Chapter 5, “OVO for UNIX Integration Installation,” on page 43 
explains how to install the integration if you are using OVO for 
UNIX with Service Desk.

• Chapter 6, “OVO for UNIX Integration Configuration,” on page 47 
explains how to configure the integration if you are using OVO for 
UNIX with Service Desk.

• Chapter 7, “User Tasks,” on page 55 provides examples on how to use 
the different features supplied with this integration.

• Chapter A, “Troubleshooting.” contains information on the default 
locations of installed files and other information that may be helpful 
in solving problems with the integration.
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Related Publications
Related Publications
This section helps you find information that is related to the information 
in this guide. It gives an overview of the  documentation and lists other 
publications you may need to refer to when using this guide.

Other Related Publications

In addition to the  documentation mentioned above, you may want to 
refer to the following publications when using this guide:

• HP OpenView Operations for UNIX: Concepts Guide

• HP OpenView Operations: Concepts Guide

• HP OpenView Operations: Installation and Administrative Task 
Guide

• HP OpenView Operations for UNIX Developer’s Toolkit: Application 
Integration Guide
Chapter 1 11
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Related Publications
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2 Integration Overview

This chapter provides an explanation of the key features and processes 
in the OpenView Operations Integration.
Chapter 2 13



Integration Overview
Feature Overview
 Feature Overview
The HP OpenView Operations integration brings together the 
functionality of HP OpenView Service Desk (hereafter known as Service 
Desk) and HP OpenView Operation (hereafter known as OVO) and 
allows the transfer of information between both. OVO monitors and 
adjusts your IT environment, while Service Desk manages the processes 
within this same IT environment. Some of the key features in this 
integration are described in the following sections.

Bidirectional Event Integration

The OVO Integration provides not only the capability to forward 
messages to Service Desk but also the ability to acknowledge these 
messages when the corresponding incident in Service Desk is closed. For 
example, when an OVO agent registers a problem with a node and a 
message is created in the OVO Management Server, the integration will 
automatically create an incident in Service Desk. This incident is then 
handled in accordance with your company ITIL processes. When the 
incident is closed, the corresponding Message in OVO is also closed. 
Based on the policy/template definitions in OVO, you are able to define 
the type of messages for each infrastructure element that needs to be 
forwarded to Service Desk. The flow of information is bidirectional; when 
the incident is created in Service Desk, an incident ID is passed back to 
OVO. 

Status Update (OVO for Windows)

The OVO Integration is designed to forward status updates to an 
incident in Service Desk when the priority of the message in OVO has 
changed. This change is automatically reflected in the corresponding 
Service Desk incident. Similarly, if you add or modify an annotation in 
OVO for Windows, this information is automatically transferred to 
Service Desk and the corresponding Service Desk incident is updated. 
Also, when closing an incident in Service Desk, it is automatically 
reflected in OVO, providing up-to-date status information for the 
operators and improving the communication between help desk 
operators and infrastructure management operators.
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Node and Services Upload

Accurate configuration items are fundamental to Service Desk 
accurately responding to faults in your system. This Integration allows 
you to upload node and service information from OVO into Service Desk 
as configuration items. The OVO Integration uses the Service Desk Data 
Exchange functionality to upload the node information into Service 
Desk. Services are only uploaded from OVO for Windows.
Chapter 2 15
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Integration Architecture and Processes
The OVO Integration comprises of several processes that allow 
communication of data between Service Desk and OVO. The following 
diagram shows the process-architecture of the OVO Integration: 
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Forward Events from OVO to Service Desk

This Integration automatically forwards OVO events from your OVO 
environment to Service Desk. See “Configuring Your Environment” on 
page 49. However, you can also manually forward events from OVO to 
Service Desk if, for example, you have not configured your environment 
to forward a particular type of event. See “Manually Forwarding 
Messages from OVO to Service Desk (OVO for UNIX)” on page 61

You can configure OVO to send all events or specific events to Service 
Desk. The event information is mapped to a Service Desk incident. The 
first time an event is sent, an incident is created in Service Desk; Service 
Desk is then the owner of that event. The import mapping in Service 
Desk defines which event attributes will be imported into the incident 
fields.

Uploading Nodes and Services from OVO into Service 
Desk

This integration allows you to upload services and nodes from your OVO 
environment to Service Desk. The upload process should be performed on 
a regular basis so that the CMDB in Service Desk contains the nodes and 
services that you are managing. See “Exporting and Importing Service 
and Nodes From OVO into Service Desk” on page 56

Forward an Incident from Service Desk to OVO

This process allows you to forward an incident to OVO as an event (also 
known as a message), if there is not already a corresponding event in 
OVO for that incident.

Send Message Annotations from Service Desk to OVO 

A message is sent to OVO stating that the event forwarded to Service 
Desk has been registered as an incident (with the corresponding incident 
number). 

Annotating a message in OVO is similar to adding a note of explanation 
to a business contract. The annotation is a short summation of the 
important points and can be used as a reference the next time you 
receive the same message. Message annotations are normally used to 
provide information on:
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• action performed to resolve the problem;

• name of the user who started the action;

• status information for the action performed;

• start and finish time of the action;

• any pre- or post action information which is relevant.

Database rules are available with this integration for sending an 
annotation to OVO whenever an incident is created as a result of an 
event being sent from OVO to Service Desk. The database rule can also 
be configured to send an annotation to the OVO application whenever 
the status of that incident changes. Database rules can be turned on/off 
and modified from the Service Desk. Service Desk agents on the OVO 
servers are sent commands, generated from a database rule in Service 
Desk.

Once the integration is installed and configured, an annotation is sent 
whenever Service Desk receives an incident from OVO. Optionally, 
whenever a Service Desk user updates the incident’s information, an 
annotation is also sent to OVO.

Send Acknowledgment Messages from Service Desk to 
OVO

Messages are to sent to OVO when an incident is closed in Service Desk 
(referred to as acknowledging an event in OVO). 

Database rules are available with this integration for acknowledging 
messages/events from OVO whenever an incident that was created as a 
result of an OVO event is closed in Service Desk. Agents on the OVO 
server are sent commands, generated by a database rule in Service Desk.

Once the integration is installed and configured, whenever an incident 
from OVO is closed in Service Desk, an acknowledgement is sent 
automatically.

Monitor Service Desk Processes and Error Log Files 
in OVO for Windows

 You can instruct OVO for Windows to monitor Service Desk log files.
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OVO policies can be used to monitor the log files for the Service Desk 
agent and the Service Desk management server. This provides you with 
a means for monitoring the integration continuously. The policies can be 
used to match specific log file lines and assign variables out of the 
intercepted lines to use for pattern matching.

Once the policies are deployed, detected errors are sent to the message 
browser automatically. Instructional text is provided with the error 
messages to help solve detected problems. Use the policy monitor 
OvSd_Monitor_sd_load_logfile to monitor the OVO management 
server. Use the policy OvSd_Monitor_Service_Desk_logfile for 
monitoring the Service Desk application server.

Suppress Node-down Messages in OVO for UNIX

When Service Desk schedules an outage (for example, a node is 
shutdown for a particular time interval), OVO automatically suppresses 
messages related to that node.

You can prevent Service Desk from receiving OVO for UNIX messages by 
letting OVO suppress the messages when an outage is planned. This is 
done by using mkoutage to retrieve data from Service Desk and pass this 
information to OVO. Two types of outages are recognized: periodic (or 
recurring outages), and occasional (or incidental outages). See “Modify 
Database Rules Related to the Outage Functionality” on page 50.

Reflect OVO for Windows updates in Service Desk 

If an incident is created in Service Desk based on a message on OVO and 
the message is updated in OVO (new annotation is sent from OVO to 
Service Desk or severity changes are sent from OVO to Service Desk), 
then the changes are reflected in Service Desk. 
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3 OVO for Windows Integration 
Installation

This chapter describes how to install the OVO Integration software, and 
provides guidelines on the correct order of installation of other necessary 
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software components. 
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About the OVO Integration (Windows) Installation
About the OVO Integration (Windows) 
Installation
The OVO Integration installs the software and the utilities that are 
needed to ceaselessly perform the integration: OvObsLoadObject and 
Data Exchange. The installation process is not fully automated; certain 
software components must be installed manually.
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Install OVO Integration on the OVO Management Server
Install OVO Integration on the OVO 
Management Server
Installation Prerequisites

• Windows installed with the latest patches and running

• OVO for Windows installed and running

• Service Desk Management Server installed and running 

• HTTP protocol enabled on the Service Desk Management Server. To 
enable the HTTP protocol: 

1. Log on to the system on which the Service Desk Management 
Server is installed. 

2. Depending on the operating system, run one of the following 
commands to launch the Server Configuration program:

— UNIX: /opt/OV/bin/OvObsServerSettingsEditor.

— Windows: Start>Programs>HP OpenView>Server Settings.

3. Navigate to the Protocols tab. 

4. Select HTTP from the Protocol drop-down list. 

5. Select the Enable this protocol check box.

6. From a command prompt, use the ovc command to restart the 
ovobs process:

ovc -restart ovobs

• Service Desk Client installed and running on the OVO Management 
Server

Before you Start the Install Procedure 

• Read the contents of Chapter 2 “Preparing to Install HP OpenView 
Service Desk 5.0” of the HP OpenView Service Desk Installation 
Guide, including the section “HP OpenView Installer – Overview” – 
this contains a description of the HP OpenView Installer and 
associated screens.
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• Ensure that you have the appropriate permissions required to install 
the software. You need Administrator privileges to install this 
software.

Install Procedure

1. Log on to the host system on which the OVO for Windows 
management server is installed.

2. Locate the execution file:

<UnpackDir>\Installer\ovowintegration\setup.exe

3. Run setup.exe to start the installation. The Introduction window of 
OpenView Installer displays.

4. The installation now follows the standard OpenView Installer 
process as described in Chapter 2 of the HP OpenView Service Desk 
Installation Guide.

5. Log in to the OVO console and deploy the OVO agent on the Service 
Desk client machine; see the OVO user documentation for 
installation instructions. This step only needs to be performed for 
Service Desk clients that need to send events to OVO. The OVO 
agent is required by the OVO integration to generate an OVO 
message from Service Desk.

6. The OVO for Windows integration, uses WBEM ODBC source driver, 
therefore WMI version 1085 core components are required. These 
components are available for Windows 2000 on the Windows 2000 
installation CD in the folder \Valueadd\Msft\Mgmt\Wbemodbc.

7. For Win2003, execute the following file:
<install_dir>\Program files\HP 
OpenView\lbin\sd\ovow\OvSdSync.exe 
to create tables in the SQL Server database. These tables contain 
records for each node and service in OVO. 

NOTE You must run OvSdSync.exe everytime you add new nodes and 
services to your OVO environment. If you want to import nodes and 
services again (for example, because new nodes and services were 
added to the OVO Management server), you must run OvSdSync.exe 
again before the import.
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8. To install OvObsAgent, execute the following file:
<UnpackDir>\Installer\agent\setup.exe

See Chapter 8 of the installation guide for further instructions.

9.  Deploy opcmsg (from the OVO console):

a. In the OVO management console, open Policies grouped by 
type.

b. Open the Open Message Interface policy group.

c. Select the opcmsg policy, right-click and then select All Tasks, 
then Deploy on. 

d. Select all of the Service Desk client nodes that you want to be 
able to manually create OVO messages from and click OK. 

Opcmsg is used to create OVO messages from Service Desk. You need 
to deploy this policy to all Service Desk clients that you want to be 
able to perform this function from. 

For additional information refer to the Online Help in your 
OpenView Operations for Windows application.

10. See Chapter 4, “OVO for Windows Integration Configuration,” on 
page 27 for further instructions on how to complete the setup of this 
integration.

WARNING To support multiple OVO Management Servers you need to 
install the OVO Integration on each server.

NOTE Once the installation steps are completed, check if the Service Desk 
agent is running (using the command ovc -status); ovobsag should be 
listed as a running service. If the service is not running, type the 
following command: ovc -start ovobsag.
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4 OVO for Windows Integration 
Configuration

This chapter provides information on the integration programs that 
allow communication between Service Desk and OVO, and how to 
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configure both systems to achieve bidirectional transfer and viewing of 
information.
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Overview
Overview
This section explains the configuration steps that must be done in 
Service Desk. The tasks are listed below:

The following will be created automatically (after uploading the 
Configuration Exchange file):

• OVO Integration account

• Database rules

• OVO Integration Role

• Import Mappings

• Templates

• Smart Action

The configuration tasks are:

• Modify the OvObsLoadObject.conf file.

• Upload the Configuration Exchange file. On Windows 2003 you must 
also upload the Windows 2003 Configuration Exchange file.

• Configure the Integration Account.

• Deploy the forwarding policy and change event policy.

• Edit logfile monitoring policies.

• Configuring the OvServiceExport tool for viewing OVO services in a 
browser. 
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Uploading Configuration Data into Service 
Desk
The OVO Integration installs configuration files that contain the 
configuration data needed by the integration. The configuration 
exchange file contains the following data:

• Integration Account

• Integration Role

• Database Rules

• Import Mappings

• Object templates

• Smart action

 To upload this configuration data into Service Desk:

• On the OpenView Console, select Configuration Exchange from the 
File menu, and then select Import. The Configuration Exchange 
Import Wizard displays. Follow the onscreen instructions and import 
the following file:

<install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\xml\OvSdOvowConfig
.xml. 

See “Importing Configuration Settings” in the OpenView online help. 

• If you installed the OVO Integration on a Windows 2003 server, you 
need to import additional configuration data in to Service Desk. On 
the OpenView Console, select Configuration Exchange from the File 
menu, and then select Import. The Configuration Exchange Import 
Wizard displays. Follow the onscreen instructions and import the 
following file:

<install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\xml\OvSdOvowConfig
2003.xml. 
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Modify Account Information in Service Desk
The integration account information in Service Desk (imported as part of 
the configuration exchange import) needs to be modified. 

1. Log on to the Openview Console.

2. The hostname must be modified to reference the OVO Management 
Server. Select the Users and Security workspace from the OV 
Configuration workspace group. Select Access>Accounts>OVO for 
Windows. In the OVO for Windows - Account dialog on the General 
tab, change Host to the hostname of the OVO Management Server. 
On the Role tab, select the Integration account role.

If you have multiple OVO Management Servers, create an 
integration account for each additional OVO Management Server. 

For single and multiple OVO Mamagement Server environments, it 
is good practice to name each account OVOW_<OVO_server_name>, 
where <OVO_server_name> is the OVO Management Server name. 
Each account name should start with OVOW.

3. Change the integration account password - This is an optional 
setting, but for security reasons it is advised to change the OVO for 
Windows account password in Service Desk. Please refer to the 
online help (Password Settings) for information on how to change 
your default passwords. The default password is 
Password4OpenV!ew.
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Modifying Configuration Files on the OVO 
Management Server
In order to insert information into Service Desk from OVO (event 
forwarding), you need to modify the OvObsLoadObject.conf 
configuration file. This file was installed during the OVO for Windows 
integration installation (see “Install OVO Integration on the OVO 
Management Server” on page 24)

To modify this file:

1. Open <install_dir>\Program Files\HP 
OpenView\Data\conf\obs\loadobject\OvObsLoadObject.conf in 
a text editor.

2. In the ACCOUNT=myusername/mypassword entry, replace mypassword 
with the previously defined integration account username and 
password. The account name must start with OVOW because Service 
Desk database rules contain conditions that are dependent on this 
naming convention.

3. Replace SERVER=localhost with the hostname of the Service Desk 
Management Server.

4. In the MAPPING=mymapping entry, replace mymapping with 
ovowindows.
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Modify and Deploy Policies on OVO Windows 
Managed Nodes
There are policies provided by this integration that allow you to monitor 
Service Desk log files. These are:

• OvSd_Monitor_sd_load_logfile.policy 

This policy allows you to monitor Service Desk log files for java 
exceptions and warnings from Agent Manager. 

Once uploaded to OVO for Windows, this policy is visible as Monitor 
sd_load_logfile.

• OvSd_Monitor_Service_Desk_logfile.policy 

Once uploaded to OVO for Windows, this policy is visible as Monitor 
Service_Desk_logfile.

The Logfile Monitoring policies must be edited through the OVO for 
Windows console in the Service Desk Policy Group, in order to have the 
policies monitor Service Desk log files (<install_dir>\Program Files\ 
HP OpenView\Data\Log). 

You need to deploy the forwaring policies on the OVO for Windows 
management server. You may also need to modify the conditions of the 
fowarding policies to avoid forwarding all events regardless of the 
circumstances. Refer to the OVO for Windows documentation for 
instructions on how to deploy and filter policies in an OVO for Windows 
environment.
Chapter 4 33



OVO for Windows Integration Configuration
Viewing OVO Services in a HTML Browser
Viewing OVO Services in a HTML Browser
To view OVO for Windows services in a browser you need to export the 
data from the OVO database using the OvServiceExport tool. This tool 
exports the data from the OVO for Windows database in either HTML or 
XML format for viewing in a browser. 

OvServiceExport Tool

OvServiceExport is a command line tool that enables you to export 
information about an OVO for Windows service.

OvServiceExport.exe accepts the following optional parameters:

OvServiceExport.exe -server <server name> -service <service 
name> [-format XML -file <file name>] ¦ [-format HTML -cgi 
<cgi root> -file <file name>]

Table 4-1 describes the parameters:

Table 4-1 OvServiceExport Command Line Parameters

Parameter Description

-server <server name> is the name of the OVO Management 
Server that holds the service information.

Default value: name of the local machine

-service <service name> is the name (not the caption) of the 
service of which you want to export information.

Default value: "Root_Services"
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-format Choose between XML and HTML:

• XML

The information is generated in XML format. This 
XML stream contains service information about the 
service <service name>, all association information 
about its dependencies and components as well as 
service information for each of these dependencies 
and components. The XML stream follows the rules 
of service.dtd, the same DTD that OpenView 
Operations for Unix uses.

• HTML

Use this option, for example, if you want to use 
OvServiceExport.exe together with CGI. The 
information is formatted in a special form of HTML. 
The HTML page includes information about the 
service <service name> as well as the information of 
its child and dependent services.

Default value: XML

-file <file name> is the name of the output file. If no file 
name is specified, the information is written to 
standard output.

Default value: none

-cgi If you use OvServiceExport.exe together with CGI, <cgi 
root> specifies the directory where the executeable is 
located on the web server.

Default value: cgi-bin

-refresh <refresh time> is the time in seconds after which the 
HTML page on your browser is updated by a new CGI 
request. This option is only applicable if you use CGI.

Default value: 60

Table 4-1 OvServiceExport Command Line Parameters (Continued)

Parameter Description
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Generating XML Output

If you want to generate an XML stream displayed on standard output, 
run the following command:

OvServiceExport.exe -format xml

You can add other parameters (see Table 4-1 on page 34) from the omand 
line.

Another example:

OvServiceExport.exe -format xml -server VPWServer -service 
VP_SM:Server -file test.xml

This example generates a file called test.xml with the service 
information of the service VP_SM:Server from the management Server 
VPWServer.

Using OvServiceExport.exe with CGI

This section describes how to use OvServiceExport.exe with CGI.

Installing OvServiceExport on a Web Server

It is important that the OvServiceExport.exe runs under an account that 
has the rights to retrieve data from OVO for Windows, as explained 
below.

Apache Web Server  If you use an Apache web server, you need to copy 
the OvServiceExport.exe file to a directory from where Apache is able to 
run CGI scripts. The Apache default directory is cgi-bin.

If you use a non-default directory, use the -cgi <cgi root> parameter 
of OvServiceExport.exe to specify it.

Normally, Apache runs the executeble file under the system account, so 
you should not have any security issues.

The htdocs directory must contain an OvServiceExport directory. The 
OvServiceExport directory must contain the two images VPW.gif and 
VPWSvcIco.gif.

Microsoft Internet Information Services 6.0

1. Create folder C:\Inetpub\cgi-bin on the OVO management server.
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2. Navigate to the <install_dir>\Program Files\HP 
OpenView\misc\sd\ovow directory.

3. Extract the OvSdServiceExport.zip file to a directory of your 
choice.

4. Copy the OvServiceExport.exe file to the C:\Inetpub\cgi-bin 
directory.

5. Copy the OvServiceExport folder to C:\Inetpub\wwwroot. Verify 
that this folder contains the VPWSvcIco.gif and VPW.gif files.

6. Open the IIS Manager (IISM).

7. In IISM under Web Sites->Default Web Site, create the cgi-bin 
directory as an IIS virtual directory. Use cgi-bin as the alias and set 
C:\Inetpub\cgi-bin as the path.

8. Right-click OvServiceExport.exe in IISM window and select 
Properties.

9. Open the File Security tab and click Edit in the Authentication and 
access control section. In the opened dialog, do the following:

• Select the Anonymous access checkbox and click Browse

• Specify a user account and password that has the rights to access 
OVO Services. Typically that would be the 
<DOMAIN>\HP-OVE-User account.

10. In the folder tree, right-click cgi-bin and select Properties. Select the 
Virtual Directory tab and verify that Execute permissions is set to 
Scripts and Executables. If not, manually select it. When prompted 
to override inheritances, select all. Accept these settings and return 
to the ISSM console.

11. In the folder tree, right-click Default Web Site and select Properties. 
Select the Home Directory tab and verify that Execute permissions 
is set to Scripts and Executables. If not, manually select it. When 
prompted to override inheritances, select all. Accept these settings 
and return to the ISSM console.

12. In the folder tree, right-click Web Service Extensions and select Add 
new Web service extension:

• Add extension name.

• Add C:\Inetpub\cgi-bin\OvExportService.exe.
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• Select the Set extension status to allowed check box.

13. Exit the ISSM console.

14. To verify that the web service viewer is working, start Internet 
Explorer and type the following URL: 
<http://<web_server_name>/cgi-bin/OvServiceExport.exe?-format+ht
ml>

Using the HTML Service Viewer of OvServiceExport

Now everything should be ready to use OvServiceExport.exe with CGI. 
The URL you need to specify in a web browser to call 
OvServiceExport.exe follows the following format: 

http://<web server name>/<cgi 
root>/OvServiceExport.exe?-format+html+ Paramneter2+<Value 
of Parameter2>+Parameter3+<Value of Parameter3>+...

Example 1  Suppose you installed OvServiceExport.exe in the cgi-bin 
directory of your Apache web server on the machine 
webserver.mydomain.com. webserver.mydomain.com is also the OVO 
Management Server. 

The easiest call would be:

http://webserver.mydomain.com/cgi-bin/OvServiceExport.exe?-f
ormat+html 

This URL would return the status of the Root_Services on 
webserver.mydomain.com. 

Example 2  Suppose you installed OvServiceExport.exe in the directory 
MyDirectory in the scripts directory of your IIS 6.0 configuration on 
the server webserver.mydomain.com. VPW.mydomain.com is the OVO 
Management Server. 

Consider the URL:

http://webserver.mydomain.com/scripts/MyDirectory/OvServiceE
xport.exe?-format 
+html+-cgi+scripts/MyDirectory+-server+VPW+-service+VP_SM:Se
rver+-refresh+120

This URL would return the status of the service VP_SM:Server from the 
management server VPW.mydomain.com. The HTML page would be 
refreshed every two minutes (120 seconds). 
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Handling of Non-ASCII Characters

OvServiceExport is able to cope with different languages. Therefore, 
within the generated XML/HTML output streams non ASCII characters 
are replaced using the following HTML syntax:

"&#x Hexadecimal value of Unicode character". 

For example, &#xDF represents the character 'ß'.

NOTE If you are using OvServerExport together with CGI, you cannot use a 
service with non-ASCII characters in its ID (the Caption field does not 
have this restriction). This would generate invalid CGI calls.

There is no similar restriction if you are writing to files. 
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Exporting Nodes and Services from OVO for 
Windows into Service Desk
To import OVO for Windows Nodes and Services into Service Desk, you 
must first export the nodes and service information from OVO into 
configuration items in Service Desk. 

Editing Configuration Files for Importing Nodes and 
Services Into Service Desk on Windows 2000

To import Nodes and Services into Service Desk from OVO for Windows 
you have to edit two configuration files. These files were installed during 
the OVO for Windows integration installation (see “Install OVO 
Integration on the OVO Management Server” on page 24).

1. Navigate to <install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config

2. OvSdOvowServices.conf - Modify this file under the DSN section, 
locate the Server entry and specify the OVO server as the value, for 
example \\MYOVOSERVER.

3. OvSdOvowCi.conf- Modify this file under the DSN section, locate the 
the Server entry and specify the OVO server as the value, for 
example \\MYOVOSERVER.

NOTE Limitations exist when mapping fields in OVO for Windows to a Service 
Desk Search code. The WMI ODBC driver requires search codes to be 
written in uppercase letters without spaces. A default attribute value 
called OVOWindowsCI is present in the import mapping as a solution to 
this limitation. If you are importing services from OVO to Service Desk, 
the caption field in OVO may contain spaces and/or wildcard characters 
which are not allowed in the search code field of Service Desk and will 
result in errors in the import log file. As a result, when an external OVO 
for Windows attribute is imported that contains spaces or is not in 
uppercase, the default value will be given. Attributes in the wrong 
format will be given the default value while others meeting the ODBC 
driver’s criteria will be imported with their true values. 
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Editing Configuration Files for Importing Nodes and Services 
Into Service Desk on Windows 2003

NOTE The OVO database user name and password used with the Openview 
DSN entry is needed to complete the following steps.

You need to edit the the following configuration files. These files were 
installed during the OVO for Windows integration installation (see 
“Install OVO Integration on the OVO Management Server” on page 24).

1. Navigate to <install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config

2. OvSdOvowServices2003.conf - Modify this file under the DSN 
section, locate the following entries:

• NAME=Openview

• USR=ovodatabase_user

• PWD=ovodatabase_user_password

Replace ovodatabase_user and ovodatabase_user_password with 
the user name and password defined when OVO was installed. 

3. OvSdOvowCi2003.conf - Modify this file under the DSN section, 
locate the following entries 

• NAME=Openview

• USR=ovodatabase_user

• PWD=ovodatabase_user_password

Replace ovodatabase_user and ovodatabase_user_password with 
the user name and password defined when OVO was installed. 
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5 OVO for UNIX Integration 
Installation

This chapter describes how to install the OVO Integration on a UNIX 
platform.
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About the OVO Integration (UNIX) 
Installation
The OVO Integration (UNIX) installs all the software and the utilities 
that are needed by the integration: OvObsLoadObject, OvObsAgent, and 
Data Exchange.
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Install OVO Integration on the OVO 
Management Server
Installation Prerequisites

• HP-UX installed with the latest patches and running

• OVO for UNIX installed and running

• Service Desk Management Server installed and running 

• HTTP protocol enabled in Server Settings on the Service Desk 
Management Server. To enable the HTTP protocol: 

1. Log on to the system on which the Service Desk Management 
Server is installed. 

2. Depending on the operating system, run one of the following 
commands to launch the Server Configuration program:

— UNIX: /opt/OV/bin/OvObsServerSettingsEditor.

— Windows: Start>Programs>HP OpenView>Server Settings.

3. Navigate to the Protocols tab. 

4. Select HTTP from the Protocol drop-down list. 

5. Select the Enable this protocol check box.

6. From a command prompt, use the ovc command to restart the 
ovobs process:

ovc -restart ovobs

• Service Desk Client installed and running (it is not mandatory to 
install the Service Desk Client on the OVO Management Server) 

Before you Start the Install Procedure 

• Read the contents of Chapter 2 “Preparing to Install HP OpenView 
Service Desk 5.0” of the HP OpenView Service Desk Installation 
Guide, including the section “HP OpenView Installer – Overview” – 
this contains a description of the HP OpenView Installer and 
associated screens.

• Ensure that you have the appropriate permissions required to install 
the software. You need root access to install this software.
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Install Procedure

1. Locate the execution file:

<UnPackDir>/ovouintegration_5.xxx.yyy_setup.bin (where xxx 
is the version number, and yyy is the build number).

2. Run the execution file to start the installation. The Introduction 
window of HP OpenView Installer displays.

3. The installation now follows the standard HP OpenView Installer 
process as described in Chapter 2 of the HP OpenView Service Desk 
Installation Guide.

NOTE The OVO for UNIX integration install procedure installs all the 
necessary software packages needed to run this integration.

4. Login to the OVO console and deploy the Openview for Operations 
agent on the Service Desk client machine; see the OVO user 
documentation for installation instructions. This step only needs to 
be performed for Service Desk clients that need to send events to 
OVO. The OVO agent is required by the OVO integration to forward 
an incident from Service Desk to the OVO management server.

5. To support multiple OVO Management Servers you need to install 
the OVO Integration on each OVO Management Server.

6. See Chapter 6, “OVO for UNIX Integration Configuration,” on 
page 47 for further instructions on how to complete the setup of this 
integration.

NOTE Once the installation steps are completed, check if the Service Desk 
agent is running on the OVO Management Server (using the command 
ovc -status); ovobsag should be listed as a running service. If the 
service is not running, type the following command: ovc -start 
ovobsag.

The installation of the integration software on the OVO Management 
Server stops the OVO agent that runs on the OVO Management Server. 
You need to restart the OVO agent manually using the command 
/opt/OV/bin/opcagt -start.
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Configuration 

This chapter describes the configuration tasks to be performed in Service 
Desk and on the OVO for UNIX Management server.
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The OVO integration configuration consists of automated and manual 
tasks:

• Upload configuration data into OVO Operations - See “Running the 
Configuration Script” on page 49

• Creation of configuration files for each OVO Management Server 
(automatic) - See “Running the Configuration Script” on page 49

• Preparation of configuration data for uploading into Service Desk 
(automatic) - See “Running the Configuration Script” on page 49

• Upload the configuration data into Service Desk (manual) - See 
“Uploading the Configuration Data into Service Desk” on page 49

• Modify database rules related to the outage functionality (manual)

• Change default passwords (manual, optional)

• Perform Configuration Tasks in OVO - See “Configuration Tasks in 
OVO” on page 52

• Deploy the Oracle JDBC Driver - See “Deploy the Oracle JDBC 
Driver” on page 52.
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Configuring Your Environment
This section describes the main configuration steps that must be 
performed before the integration can begin the bidirectional transfer of 
information between OVO and Service Desk.

Running the Configuration Script

This section describes the tasks that you need to perform in order to 
properly configure your system for this integration. To start the 
configuration process, run the following command on the OVO 
Management Server: /opt/OV/bin/ovsdovosetup.sh 

Follow the onscreen instructions. Once the script has completed, perform 
the tasks described in the following sections.

Uploading the Configuration Data into Service Desk 

To upload configuration data into Service Desk, perform the following 
tasks:

• Upload the Service Desk configuration data using the Service Desk 
client. After running the ovvsdovosetup.sh script (this file prepares 
the configuration data file for uploading), copy the file 
/var/opt/OV/conf/obs/data_exchange/ovsdintegrationsdconf
ig.xml to a Service Desk client machine. Start the Service Desk 
client and select File>Configuration Exchange>Import. The 
Configuration-Exchange Import Wizard appears. Click Next on the 
first page of the import wizard and click Add, and browse to the 
directory containing ovsdintegrationsdconfig.xml, select this file, 
and click Start import. After importing the configuration data, exit 
the client. 

If you have multiple OVO Management Servers, you need to run the 
ovsdovosetup.sh script for each server. 
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NOTE You only need to upload the Service Desk configuration data once. 
Therefore, do not upload the configuration data into Service Desk if 
you have already performed an upload during the configuration of 
the first OVO Management Server.

You need to create an integration account for each additional OVO 
Management Server. Check that the following information is 
supplied under Accounts in the OpenView Console:

— The Account name starts with OVOU. 

It is good practice to include the name of the OVO management 
server in the name of the account. For example, if the hostname 
of your OVO management server is merlin, name the account 
OVOU_merlin.

— In Host, type the hostname of the OVO Management Server.

— Set Account Type to Integration.

— Under the Roles tab, select the OVO Integration role

Modify Database Rules Related to the Outage 
Functionality 

You need to modify four database rules to facilitate outage work. These 
rules are:

• OVO occasional outage from work order - For workorders

• OVO periodic outage from CI - For configuration items

• OVO periodic outage from schedule - For schedules

• OVO periodic outage from schedule element- For schedule elements

To modify database rules:

1. Log into the HP OpenView Console using a role that includes 
administrator privileges and select the work-space category 
HP OpenView Configuration. Detailed information on database 
rules is available in the online help.
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2.  Navigate to the Actions & Rules work space. In the Actions & Rules 
tree, select Rules. 

3. In the Rules tree, select Database Rules. First, select the object 
(Workorder, Schedule, Configuration Item, and Schedule Element) 
and then select the rule you need to modify:

• OVO occasional outage from work order

• OVO periodic outage from CI 

• OVO periodic outage from schedule 

• OVO periodic outage from schedule element

4. Navigate to the Command Exec action page of the database rules 
wizard and click Edit for the action you want to modify (under “What 
actions do you want to be performed?”). 

5. The Command Exec Action window displays. Enter the hostname of 
the OVO Management Server (in place of 
myovoserver.mydomain.com) in the Host section. 

NOTE If you have multiple OVO Management Servers, you need to create 
additional Command Exec Actions in Service Desk for each server. Enter 
the hostname for each management server in your system.

Change Default Passwords (manual, optional)

This is an optional setting, but for security reasons it is advised to 
change the OVO for UNIX and OVO for UNIX Outage account passwords 
in Service Desk. Please refer to the online help (Password Settings) for 
information on how to change your default passwords. The default 
password is Password4OpenV!ew.

Once the passwords are changed in Service Desk, you have to duplicate 
these changes in the Integration configuration files on the OVO 
Management Server. Open the configuration files in a text editor and 
locate the password entry. The files are:

• ovsdmkoutage.conf: located in var/opt/OV/conf/sd

• ovsdevent.conf: located in var/opt/OV/conf/obs/loadobject
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NOTE If you run the ovsdovosetup.sh script more than once after you changed 
the passwords, you must repeat the password change as described in this 
section. The account passwords that you have already specified above are 
replaced by default passwords every time the script is executed.

The OVO for UNIX Outage account consumes one named user license. 
An integration account cannot be used.

Configuration Tasks in OVO

Log in to the OVO console and add the responsibility of the Service Desk 
message group to the appropriate operators.

Log in to the OVO console and configure OVO message source templates 
by switching on the Forward to Trouble Ticket for messages you want 
forwarded to Service Desk. Assign and install/update the modified 
templates to the managed node(s). See the OVO for UNIX user 
documentation for detailed instructions.

Deploy the Oracle JDBC Driver

Copy the Oracle JDBC driver ojdbc14.jar to the directory 
/opt/OV/java/drivers on the OVO Management Server; this file is 
located on the Service Desk management server in the nonOV/obs 
subdirectory of the installation directory. The Oracle JDBC driver is 
required for accessing the OVO Oracle database. 

Make sure the jar file has the correct ownership and permissions. The 
file must be owned by bin and must be in the bin group. Issue the 
following command from a command line to set the correct ownership: 

chown bin:bin ojdbc14.jar 

The permissions of the jar file must be read-only for everyone. Issue the 
following command from a command line to set the correct permissions:

chmod 444 ojdbc14.jar
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NOTE The Oracle JDBC driver must be deployed on each OVO Management 
Server.
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7 User Tasks

This chapter describes the OVO Integration tasks that need to be 
performed on a regular basis. 
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Exporting and Importing Service and Nodes 
From OVO into Service Desk
All nodes and services managed by OVO should have a corresponding 
configuration item in Service Desk. This task needs to be performed so 
that events coming from the OVO server can be linked with the correct 
configuration item in the Service Desk database. 

NOTE The OVO Management Server is also a managed node. 

Importing Nodes and Services From OVO for 
Windows

Nodes can be imported from the OVO for Windows Management server 
as follows:

NOTE Pre-requisite: On Windows 2003 (not applicable for Windows 2000), 
navigate to <install_dir>\Program Files\HP 
OpenView\lbin\sd\ovow\ and run ovsdsync.exe from the command 
prompt window. This will configure the OVO SQL Server database so 
that the database tables are populated by OVO Services and Nodes, and 
made readable for Service Desk.

1.  In the OpenView Console, navigate to Data workspace in the OV 
Configuration Workspace group. 

2. In the Data treeview, select Data Exchange>Data Exchange Task.

3. Select File>New>Data Exchange Task. The New-Data Exchange 
Task dialog box appears.

4. To export the nodes from OVO for Windows, select Export and using 
Quick Find, navigate to <install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config\OvSdOvowCi.
conf and click Open. If you are using Windows 2003, select 
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<install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config\OvSdOvowCi2
003.conf.

5. For exporting Services, select Export and using Quick Find, navigate 
to <install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config\OvSdOvowSer
vices.conf and click Open. If you are running on Windows 2003, 
select <install_dir>\Program Files\HP 
OpenView\Data\Datafiles\data_exchange\config\OvSdOvowSer
vices2003.conf.

6. Specify the name and location of the Exchange file (temporary file) 
that will be populated with the results of the export process as 
defined in the respective configuration files.

7. Select Import and using Quick Find, select the Application Account 
that you want to use for importing (the account name should begin 
with OVOW).

8. Select the correct import mapping using Quick Find,

• OvSdOvowCi (import mapping for configuration items)

• OvSdOvowServices (import mapping for Services)

• OvSdOvowCi2003 (import mapping for configuration items on 
Windows 2003

• OvSdOvowServices2003 (import mapping for Services on 
Windows 2003

9. Save and close the New-Data Exchange Task dialog.

10. Right-click on the newly created Data Exchange Task and select 
Start. 

11. The Import Process dialog boxc appears and shows the progress of 
the import/export process. When finished, close this dialog box.

For additional information about how to use Data Exchange for 
exporting and importing data, please refer to the HP OpenView Service 
Desk: Data Exchange Administrator’s Guide.
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Importing Nodes from OVO for UNIX 

The ovsdexchovonodes.sh script extracts the nodes from OVO and 
imports them into Service Desk. This script can be started from the 
application bank in the OVO user interface. This script calls 
OvObsExporter to export the node data into an XML file, and then calls 
OvObsImporter to import the node data from this XML file into Service 
Desk. 

For additional information on modifying the import mapping, refer to the 
Chapter entitled “Import Mapping” in the HP OpenView Service Desk: 
Data Exchange Administrator’s Guide.
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Manually Creating a Configuration Item 
You can manually create configuration items in Service Desk for all or 
part of your managed nodes. Refer to the Service Desk online help for 
detailed instructions on how to create a configuration item for a 
managed node:

1. Open a new Configuration Item dialog. This can be done by selecting 
Configuration Item from the shortcut bar or selecting New then 
Configuration Item from the File menu.

2. In the Search code field, enter the name of the managed node. 

3. In the Name field, enter the Fully Qualified Domain Name (FQDN) 
for the managed node.

The Name field is used by the OVO Integration to identify the 
configuration item. The incident that is created by the OVO Integration 
relates the configuration item to the incident using the Name field. The 
configuration item corresponds to the node the incident originates from.

If the Name field does not contain the FQDN, the incident is still created, 
but the Configuration Item field of the incident will be empty, which 
makes the incident less useful.
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Forwarding Messages
This section describes the message-forwarding functionality of the OVO 
Integration.

By default, messages in OVO have the Service Desk Management Server 
in the node field and the Configuration Item of the incident in the object 
field.

You can arrange to have the name of the configuration item instead of 
the Service Desk Management Server displayed in the node field. You 
can do this by modifying the Send Incident To OV Operations smart 
action.

To modify the smart action:

1. Log on to the system on which the OVO integration and Service Desk 
client are installed.

2. From the OpenView Console, select the Actions and Rules workspace 
from the OV Configuration workspace group. 

3. Select Actions > Smart Action > Incident.

The smart actions for incidents are listed in the right panel.

4. Right-click the Send Incident To OV Operations smart action and 
select Edit.

The Send Incident To OV Operations Smart Action dialog box opens.

5. Add a new line to the list of parameters, type node=, click Insert 
Attribute, then select Configuration Item> Name.

The new parameter should be displayed as follows in the list of 
parameters:

node=[Configuration Item;Name]

6. Click OK.
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Manually Forward Messages to OVO from Service 
Desk

Smart actions are available for this integration. A smart action makes it 
possible for users to forward a message to the OVO Management Server 
to notify the OVO operators that a problem is detected. 

To manually create an event in OVO based on an incident in Service 
Desk:

• Open an existing incident form in Service Desk. Check that the 
severity field is not empty.

• On the menu bar, select Action> Send Incident To OV Operations.

The incident is then forwarded to OVO and is displayed in the OVO 
Message browser.

Manually Forwarding Messages from OVO to Service 
Desk (OVO for UNIX)

This feature makes it possible for users to manually forward a message 
to Service Desk. You may need to manually forward a message when:

• A message is created that was not detected by the automatic fault 
detection application

• A message is created that is not configured to be sent to Service 
Desk.

To manually forward messages:

1. Open the message browser in the OVO Console.

2. Select the messages you want to forward.

3. From the Application Bank select Insert Incidents. The selected 
messages are sent to Service Desk.

4. The severity label will turn white when a message is sent to Service 
Desk, showing that Service Desk now owns the message. 
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Outage Planning (OVO for UNIX)
You can prevent Service Desk from receiving OVO for UNIX server 
messages by letting OVO suppress the messages when an outage is 
planned. This is done by using mkoutage to download outage information 
from Service Desk and upload this information into OVO. The download 
and upload processes are performed automatically through the use of 
database rules in Service Desk. Two types of outages are recognized: 
periodic (or recurring outages) and occasional (or incidental outages). 
Outage planning is an administrative task in Service Desk, and it can 
only be used to suppress messages when installed with the OVO 
integration.

NOTE It is not possible to automatically detect if outage periods manually 
entered on your OVO server application conflict with outage periods sent 
from Service Desk. If a conflict occurs, the result may be an error in the 
outage time period in the OVO application.

To define outages in Service Desk:

• To enter occasional planned outages in the work order dialog box, see 
the Plan Incidental Outages topic in the Online Help.

• To enter Periodic Outages in Service Desk, navigate to the 
Configuration Item form, select the Downtime tab, and click New. 
The New-Schedule-CI dialog appears. Select the previously defined 
schedule and select Planned Downtime from the Type drop-down list 
and click OK.
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Viewing OVO Service State 
A browser can be used to view all services that are not working or just 
top level services that are not working, depending on the URL used. The 
services are color coded to show the level of importance: red equals 
critical; orange equals major; yellow equals minor; and light blue (Cyan) 
equals warning. The following scenarios are designed to give you an idea 
of how this feature might be used:

• A support manager wants an update on the state of the top level 
OVO services that are down. The manager clicks the Top OVO 
services shortcut on the desktop and gets a view of all top level 
services currently down.

• A specialist is working at a customer site and needs an update on the 
services that are down. The specialist enters the service viewer URL, 
in the browser of a computer with Internet access, and gets a view of 
all services that are down. 

• The customer support center begins to receive numerous calls for 
service. To get a quick overview of services that are currently down 
the help desk engineer uses the Service viewer shortcut on the 
desktop to quickly locate the down service and answer the calls.
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